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About this Manual

This User Guide includes the information you need to use the ECR Station 
Viewer interface, one of the three main interfaces for the ECR Call 
Recording System.

Who this Manual is for This manual is for “non-supervisor” end users who require access to the 
call records for a specific telephone station. 

How this manual is 
organized

This manual is organized into four main sections.

The first section (“The ECR Station Viewer Interface” on page 4) provides 
an overview of the ECR Station Viewer and introduces users to the main 
elements of the program, including the three main views in the program 
(Station View, Statistics, and Call Finder).

The next section (“Call Record Context Functions” on page 10) provides a 
description of all the things you can do when you select a call record. This 
includes playing the record, emailing it, adding a comment to it, protecting 
it, locking it, and much more.

The third section (“Tools Menu Functions” on page 15) provides a 
description of various functions you can perform using the items under the 
Tools menu. This includes maintaining recording hardware, shutting down 
the recording system, exporting data to Excel, and changing the user 
password.

The final section (“Options” on page 17) describes the  various settings of 
the program from the Tools>Options menu. 

Related 
Documentation and 
Software

• ECR Installation and Setup Guide
• ECR Supervisor User Guide
• ECR Configuration Tool User Guide
• Hardware Quick-Start Guides

Support Information ECR includes one year of support from the date of purchase. Support 
agreements are available to extend this support period. Please contact Algo 
for information and pricing.
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The ECR Station Viewer Interface
The ECR Station Viewer provides non-supervisory access to call records for 
specific telephone stations. Subject to privileges granted by the ECR 
Administrator, ECR Station Viewer users will be able to search for and play 
back past call records, add comments, create statistical reports, send 
emails of recorded calls, and much more.

Users accessing a station with the ECR Station Viewer are logged on as the 
Station Operator, allowing ECR to track calls made by that user. 

Getting Familiar

The Station Viewer Interface is made up of three main views:

• Station View (default startup view)
• Statistics
• Call Finder

Common Elements There are several common elements to the View windows in the ECR 
Station Viewer  Interface. These include:

• The Drop-Down Menu at the top of the screen
• Toolbar
• View Tabs
• Call Playback Panel

Drop-Down Menu

The drop-down menu provides a consistent navigation system throughout 
the Station Viewer  Interface, available from all three  main views.

Toolbar

The Toolbar contains icons for quick feature selection. For detailed 
information on these icons, please refer to “Call Record Context Functions” 
on page 10 . The Toolbar icons are greyed out when a call record is not 
actively selected.

View Tabs   
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The View Tabs make it easy to switch between Views. Simply click on the 
tabs to change to the selected view.

Player Panel

The Player Panel is for playing back selected call records. For more 
information on this panel, please refer to “Tools Menu Functions” on 
page 15 .

Station View

The Station View is the primary interface to play back and manage 
recorded conversations. 

Telephone Status 
Panel

Along with Set Display and real-time Call Duration information, an 
animated graphic in the Telephone Status Panel provides a visual 
representation of telephone status. While on a call users can enter 
comments about the call in the Comments field. 

Call History List The Call History List contains a listing of recent calls for the Station. To 
operate on a call record, left click on the desired call in the list  and use the 
Toolbar to execute the desired operation. Alternatively, right-clicking on a 
call record pops up a handy quick menu including all the functions of the 
Toolbar in addition to items in the File and Edit menus.

To play back a call, left click on the desired call then use the playback 
controls at the bottom of the screen. Along with basic play, pause and stop 
controls, playback time and volume can be changed by use of the slider 
controls (refer to “Tools Menu Functions” on page 15).

Drop-Down Menu

Toolbar

View Tabs

Telephone Status

Panel

Call History List

Player Panel
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The Call History List list displays all of the relevant information related to 
each call record. This includes the start time, duration, set display, user 
entered comments, type of call, protection status, call record filename, and 
the file format (wma or wav).

• Clicking on each column heading automatically sorts the call records. 
You can use this feature to easily sort or locate calls.

• Each column is resizable. Just click on the border between two column 
headings and drag to the desired size.

• By selecting a call record and right-clicking, you can play or email the 
record, add or edit comments, edit set display text, delete the record, 
protect the record from automatic deletion (or unprotect it), save the 
record as an external file, or copy the record to another directory.

• Because ECR call records are Windows files, they can be selected, cop-
ied, or dragged-and-dropped from the Call History List to different 
folders, back-up media, emails, or your desktop.

Call History List 
Column Descriptions

Start Time Time and date of the start of the call.

Duration The duration of the recorded conversation with one second resolution.

Set Display Contains outbound dialled number and inbound Caller ID. Other details 
may be captured depending on telephone technology and the model of the 
attached recorder device.

Comments During a call, comments can be added in real-time via the comments filed 
in the Telephone Status Panel. After the call is completed, comments can be 
added to the call record by using the Comments command in the Toolbar 
or by right-clicking a call record and choosing Comments.

Type Type of call: Outgoing, Incoming, or Missed Call. 
Note: The type of call is based on the ring cadence detected at the 
telephone. For systems where the telephone does not ring, or only provides 
a single alerting tone on an inbound call, some calls may be incorrectly 
flagged as “outbound”.

User The name of the User for which the call was recorded.

Protect The status of the Protect flag. If protected, the record will indicate ‘YES’.

Locked By Indicates whether the call record is locked and, if so, by what user.

Call Record File The file name of the call record file.

Format The type of call record file. The default is .wma (Windows Media file).
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Call Finder

Call Finder is a powerful search utility that allows for easy retrieval of calls 
in the database. Call Finder displays all calls in the database that meet the 
specified search criteria. All matches will be displayed - there is no limit to 
the number of records that can be listed.

For example, if no criteria are selected, executing the search will display all 
call records in the database at the time that the search is started (this differs 
from the Station View which normally lists only a limited number of the most 
recent calls, but updates as new calls are created).

A number of search parameters are accepted to perform a search as 
defined below:

Searching Station Allows Station specific or global searches. Stations not included on the 
User’s allowed Station list will not be accessible from the Call Finder.

Date The calls searched will be limited to the interval between the dates specified 
in the Calls From and Calls To fields. Default value interval is all calls 
recorded since installation

Comments Allows search based on user-entered comments. Any portion of the call 
record comment matching the search parameter will return a positive 
match.

Set display Allows search based on set display information (Caller ID and dialled 
number).

For example, searching by area code can quickly return all calls from a 
particular region.

Searching a complete phone number will return all call records with that 
number appearing in inbound (Caller ID), or outbound (dialled on 
telephone)

Length of call Searches can be based on call durations. Common uses are to screen out 
short calls or search for abnormally long calls
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User Allows limiting of search to all made by a specific User. Note that the User 
must be logged in as an Operator while taking calls to have User 
information appended to the record

Call type Allows limiting of search to Incoming, Outgoing, or Missed Calls. 

Statistics

ECR keeps track of telephone usage and can provide interesting and useful 
statistical information. Depending on what privileges a user is granted, 
data can be calculated based on all Stations, specific Stations, or the 
current station. Data can also be limited based on a range of dates.

To access this information:

1. Click the Statistics tab, or select View>Call Statistics.
2. Select the desired Station setting.
3. Choose the desired From and To dates.
4. Click the Generate statistics report button.

Available statistical information includes:

• Number of telephone calls made outbound
• Number of telephone call received
• Number of missed telephone calls
• Number of imported calls
• Longest, shortest, and oldest call, and
• Average call duration

Data appearing on screen can be exported to 
Microsoft Excel® using the Export to Excel feature 
found in the Tools menu. 
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Player Panel

Use the Player Panel to control and monitor the playback of a selected call 
record. The Player Panel includes the following information and controls:

Playback File Provides the name of the currently selected call record file.

Playback Progress 
Slider

Provides a visual timeline indication of the playback progress and also 
allows you to quickly jump ahead or back to sections of the call record file.  
To use the slider, left-click click the slider, hold the mouse button down, then 
drag the slider to the portion of the call record you want to listen to.  
Alternatively, you can left-click anywhere on the timeline to make the 
playback jump forward or backward.

Playback Progress 
Summary

Provides information of how long the current call record file is and how far 
along the the playback has progressed (in minutes and seconds).

Playback Buttons Use the basic Play, Pause, and Stop buttons to control the playback of the 
call record file.

Volume Slider Drag the volume slider to control the playback volume of the call record 
file. If you are unable to generate enough volume, try adjusting your PC 
audio settings or turn up the volume controls on your speakers.

Play Speed Slider This control allows you adjust the speed of the playback of the call record 
file with minimal effect on the clarity of the content. A slow speed is useful if 
you have to type out a written record of a file and want to ensure the 
conversation is slow enough for you to keep up. A faster speed allows you 
to quickly scan through a file to find a particular piece of information.   

Play Speed

SliderVolume Slider

Play

Pause

Stop

Playback File

Playback

Progress

Slider

Playback Progress 

Summary

Playback 

Buttons
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Call Record Context Functions
Call Record context functions are available for use when 
a call record is highlighted in either the Station View or 
Call Finder. The complete list of call record functions is 
available by right-clicking on a call record. A subset of 
these functions is also available from the Toolbar. In 
addition, when a call record is highlighted, the Play 
function can be accessed from the Player Panel at the 
bottom of the screen.

Note that unless a call record is highlighted, all toolbar 
icons will be greyed out.

Note also that not all Call Record context functions may be available to all 
users. This is because the privilege to use these functions is set by the ECR 
System Administrator. Contact your system administrator if you do not have 
the priveleges to use any of the following functions.

Play

Plays back a call record file. For full playback control of call records, refer 
to “Player Panel” on page 9 .

Email

Call records may be easily emailed as attachments by simply highlighting 
one or more call records and choosing the Email function. A new email 
composition window will open (using your default email software) with the 
call record(s) pre-attached. In addition, the call detail and comments are 
inserted into the text body. 

Note: In order to use this feature, a MAPI compliant email program must 
be installed. Microsoft® Outlook® and Outlook Express® are configured 
correctly by default, however Netscape® requires the MAPI option to be 
selected in the email program setup. Email signature attachment is only 
supported with Microsoft Outlook.

Standard Windows controls work in the Call List window to select multiple 
call records - for example, holding the CTRL key while clicking the selected 
call records you wish to email.
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ECR will also include an “Algo Recorded” line of text in the email message. 
This text line may be deleted manually and set to not be displayed by 
unchecking the Display Recorded message checkbox in 
Tools>Options>User Display Settings.

Any of the automatically inserted text may, of course, be edited or deleted if 
you do not wish to share this information with your recipient. Keep in mind 
that this information is also embedded in the audio file (e.g. comment text), 
but will not be retrieved by Windows Media Player.

Comments

Adding comments to a call record not only helps summarize the contents of 
a call but also makes search and retrieval much easier at a later date.

Anytime while recording a call, comments (up to 200 characters) can be 
typed into the Comments bar in the Current Call section of the Station 
View.

Once a call is saved, 
comments may be added or 
edited by selecting the 
Comments function. You can 
then add or edit text in the 
Comment text box.

Comments are embedded into call records, just like Caller ID and other 
data, to be retrieved by Client Call Recorder.

Quick Find

The Quick Find function 
allows you to quickly search 
all the fields in the displayed 
call list in the current view 
window (can be Station View 
or Call Finder Views). The 
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function highlights any call records in the current view window, from ANY 
field, that match the text entered in the Quick Find search box. Note that for 
full search capabilities on all calls in the local ECR database, use the Call 
Finder function.

Delete

The Delete function allows you to delete one or more call records that have 
been selected in the Call List window. Note that the delete key on the 
keyboard will perform the same function. Note also that the Delete function 
will not delete protected records. To delete a protected record, first 
unprotect the record, then delete it.

Protect

Allows you to protect a call record so that it cannot be deleted (manually or 
automatically) within the ECR system. This feature ensures that a call record 
will remain in the ECR database even if the Automatic Delete function is set.

In addition, protected call records will not be counted as part of the 
Number of Calls limit set for the Automatic Delete function (if used). For 
example, if you have set the Number of Calls limit to 20 calls and have 
protected two calls, you will store the two protected calls plus the 20 most 
recent calls.

To protect a call record, select the record then choose the Protect function. 
To manually delete a protected call record, first unprotect it, then delete it.

Unprotect

Disables the Protect feature.
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Lock

Prevents the call record from being played, emailed or viewed by other 
Operators.

Unlock

Disables the Lock feature.

Edit Set Display

Allows you to edit the 
automatically-generated text in a 
call record’s set display field, up 
to a maximum of 200 
characters.

Save As

Allows you to save a call record 
under a different name or to a 
different location on your 
computer or storage media.
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Copy

Allows you to copy selected call 
records to a different directory 
on your computer or storage 
media. To use this function, first 
select the call records of interest 
from the Station View or Call 
Finder views, choose Copy, then 
select the target folder to copy 
to.

Select All

Selects all the call records in the currently displayed call list.  
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Tools Menu Functions
System wide options and control is available from 
the Tools drop down menu. Each feature available 
from this menu item is detailed below.

Hardware Maintenance

If there is recording hardware attached to your PC, the Hardware 
Maintenance interface provides access to these devices for programming 
firmware and Serial Numbers. 

Note that before accessing these 
devices, the recording system will 
need to be temporarily shut down.

All recording devices attached to 
the PC will be listed in the 
Maintenance window. The Serial Number, Firmware Version, and Type of 
Algo Recorder are listed.

Recorders can be disconnected or 
connected to the PC with the 
maintenance window open. Click 
the <Refresh List> button to 
update the listing.

To program a recorder, left click on 
a listed recorder. The lights on the 
front of the selected recorder will 
flash when selected. Then click on 
the buttons at the bottom of the window to perform the desired operation.

To upgrade the Firmware of all attached 4102 AuxBoxes and 4102R 
AuxCards simultaneously, right click on any listed recorder and select 
<Upgrade all 4102 AuxBoxes>.
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Recording System Commands

This function allows you to start, shut down, or 
restart any call recording hardware you may 
have attached to your PC. Use these 
commands with caution as critical call 
recording can be disrupted. 

Export Data to Excel

This function will export all data displayed in the view window to Microsoft 
Excel. This function is available from all three main views of the ECR Station 
Viewer (Station View, Statistics, and Call Finder). 

Change password

Allows the currently logged in User 
a quick means to change their 
password.
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Options

User Display Settings

This tab includes options for controlling 
how many recent calls will be displayed 
in the Station View’s Call History List of 
call records.  In addition, this tab allows 
you to set the format of the date display 
of call records and to control the 
automatically-inserted text that goes into 
generated emails.

The settings in this tab apply to the 
Station View window for the user’s ECR 
Station Viewer as well as for the ECR 
Supervisor (if enabled for that user).

The display of calls can be limited by:

• Number of calls (up to 999)
• Period of time (up to 30 days for the ‘Days’ drop-down box, and up to 

24 hours for the ‘Hours’ drop-down box)

Email Settings • The Enable Signature Display setting allows you to automatically 
include Email signature text (from your email client) into any emails sent 
from ECR.

• Unchecking the default “Algo Recorded” message setting allows you to 
remove the automatically inserted message text (e.g. “This call was 
recorded using an Algo 4105 Analog Auxbox with the Enterprise Call 
Recorder V2.2 software”) displayed in the emails.
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Station Settings

The Station Settings tab allows 
users to set:

• the status of the Hidden 
Mode

• whether Missed Call 
records will be generated 
and, if so, the time delay 
associated with generating 
those records

• the audio recording format 
and associated file size and 
compression for the call 
record files

Hidden Mode This option disables the Windows system tray icon for the station. 

Record Missed Calls  You can choose to have ECR log missed calls or not for the station.  A log 
of missed calls can be very useful to gauge telephone activity.

When enabled, ECR will generate a missed call record whenever the 
telephone rings but is not picked up. This record stores the time and date of 
the call as well as Caller ID information.

Missed Call Delay This option defines the interval ECR waits at the end of ringing before a 
missed call record is generated. The adjustment compensates for ring 
cadence variations and delays between ring and the telephone in-use 
events. Adjust the detection delay if missed calls are generating multiple 
records. Note that while the time delay can be set for up to 30 seconds, a 
typical setting will be 4 to 5 seconds.

Recording Format ECR allows calls to be stored in 
either WAV format (raw 8kHz, 16bit 
data) or compressed Windows 
Media Audio® (WMA). The WMA 
data rate is selectable from pull 
down menu. WAV recording 
provides the best recording quality, 
but consumes storage space very quickly: 29 MB per hour.

Note that logging missed calls should be 
disabled when a single inbound call rings 
multiple telephones, as in hunt groups, to avoid 
large scale generation of missed call records
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The WMA recording compression can be set to either 3MB or 5MB per 
hour. The 5MB per hour setting offers improved audio quality at the 
expense of increased storage usage.  

Filter Calls

 Designed for usewhen the Save Mode 
is set to Automatic Record, the Filter 
Calls function can be used to avoid 
automatic recording of routine calls 
such as personal calls to or from a 
home telephone. Note that users can 
override this function and manually save 
files, if desired.

Filter by patterns Up to ten different phone numbers (or alphanumeric strings or 'patterns') 
can be entered into the Filter by patterns list that will be used to prevent 
calls from being automatically saved.

This function works by searching for the pattern in the set display. Thus, you 
can enter partial text or numbers instead of exact phone numbers or 
names. If there is a match, the call record is not saved.

Note that ECR will look for any match, so if you enter just "9" in the Filter 
Calls list, any number dialed that includes a 9 will not be recorded. Make 
sure you test your Filter Calls string to ensure you get the results you intend.
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Recording

The Recording tab allows users 
to set:

• whether calls will be saved 
automatically - or manually 
by the user

• what phone or keyboard 
keys users can use to trig-
ger the manual saving of 
call records or the setting 
of the call record protect 
flag

• what key can be used to 
toggle recording on or off

Save Mode Sets the Station Save Mode to either Automatic Record or Manual Record.

In Automatic Record mode, ALL station calls (including inbound, outbound, 
and missed calls) are automatically recorded and saved to the ECR 
database with the exception of:

• calls where the set display matches any of the patterns in the Filter Calls 
list, if configured 

• Missed calls if the Record Missed Calls function is turned off .

In Manual Save mode, only those calls a user manually selects are saved 
into the ECR database.

Phone HotKeys ECR supports two types of on-demand recording: Entire save (Save Key); 
and toggle record (Record Key).

Save Key Press the Save Key to store an entire call at any point during the 
conversation, or after the call has ended. ECR caches the last conversation 
to allow the call to be saved. A new call deletes the cached previous call.

Note: This feature is useful in Manual Mode as it allows the unsaved last 
call to be saved.

Record Key The Record Key allows a portion of a conversation to be stored as a call 
record. The first press of the Record Key begins audio recording from that 
point. A second press will stop recording and generate a call record 
containing the enclosed portion of conversation.   
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AuxBox Configuration

The AuxBox Configuration tab allows 
you to set various relay modes for a 
station’s AuxBox or AuxCard 
hardware, select audio levels, audio 
recording modes, and speech 
decoding modes.

Select AuxBox Relay 
Modes

The relay output(s) on the Station recorder can be configured to activate on 
different telephone states.

Depending on the AuxBox recorder attached, some selections may be 
disabled.

'All Modes' activates the relay on all event triggers with the exception of 
'Save Activated'. Fast flash for Ring, on solid when In-Use, slow flash when 
a message is waiting.

'Save Activated' mode call is triggered when a call is set to be saved - either 
because the station is operating in automatic save mode or because 
manual recording has been triggered.

Select Audio Level The digital and analog audio level is adjustable between two levels: Low 
and High. The low level provides more dynamic range for improved quality. 
The high maximizes audio gain to correct for low source audio levels.

Audio Recording Audio output can be limited to receive audio only for applications that do 
not want the near side caller recorded. Radio call-in shows and radio 
dispatching are common uses for this feature.

Select Speech 
Decoding

Audio on Nortel digital TDM telephones is encoded differently depending 
on region. For North America, this setting should be uLaw. In Europe, the 
setting should be aLaw.

Improper configuration of this setting will result in recordings that are 
unintelligible and garbled.
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Call Record Storage

To help manage call record files, ECR 
includes several options to help keep 
storage requirements low. You can 
choose to automatically delete call 
record files based on how old they 
are (number of days), how many 
there are, or how much hard disk 
space (in MB) they take up. 

Limit Call Storage By The size of the call record database can be limited in three ways:

1. By call record date
2. Number of call records in the database
3. By disk space used

When limiting by number of days, call records older then the defined limit 
are automatically deleted from the call database.

Cautions When limiting by number of calls or disk space, the oldest calls are deleted 
automatically once the defined limit is reached. If you set the system to 
automatically delete records based on days, number of calls, or storage 
space, keep in mind that there is a risk that you could occasionally delete 
wanted files. Therefore, it is important to set these conditions properly. 
Consider the following problematic cases:

Limiting by Number of
Calls

If someone calls the station fifty times one day while the user is out, it may 
prematurely push important records into the recycle bin.

Limiting by Number of
Days

If the user at the station has a schedule disruption, like an extended 
business trip, some of the call records they may have been expecting to 
review upon return may have already been deleted.

Limiting by Storage MB If a user at the station has one or more lengthy conversations that use up a 
lot of memory, it may prematurely push important records into the recycle 
bin. 
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